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Introduction 
The following release notes describe the significant new features that are available in V-STARS 
Version 4.5. 
 
The release notes also describe many of the software fixes implemented since the previous 
release (V-STARS Version 4.4). 
 
All care has been taken to ensure that the software is functional and operates as it should. This 
software has passed all internal testing. Although this testing is thorough, it is by no means 
complete. We cannot run through all the possible combinations and applications that our large 
and varied user base performs. We therefore urge you to try out the new features as much as 
possible in the next few weeks to confirm that they work properly. Please notify us as soon as 
possible of any problems you find so they can be fixed in the next formal release. 
 
Throughout this guide NOTE: denotes particularly useful information. Additionally, WARNING! 
indicates that special attention should be paid to the information provided to avoid an 
undesirable result. 
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Known Issues 

Opening Projects on CD-ROM or DVD 
If you open a V-STARS project that is on a CD-ROM or DVD, none of the changes you make 
will be saved when you close the project.  (V-STARS cannot write data to a CD-ROM or DVD).  
If you do this, V-STARS will display a warning message.  This is an issue with all versions of V-
STARS not just this release, so it is important you are aware of it.   If you want to save changes 
to such a project, first copy the project from the CD-ROM or DVD to your disk drive.    

3D File Format Changed   
Improvements in this release required a change in the 3D file format. This means that earlier 
versions of V-STARS will not work on projects created with the new release, but this new 
release will work on projects created by any previous versions of V-STARS. If you try to run 
earlier V-STARS versions on V-STARS 4.5 projects, you will get a message stating that you 
cannot do this. Also, when the new release is run on an existing project, it will write any existing 
and any new 3D files in the new 3D file format which means previous versions of V-STARS will 
no longer work with that project. 
 
When the new V-STARS opens a project made by a previous version of V-STARS, it makes a 
backup of the project so you can still run the original project with previous versions of V-STARS. 
The backup data is located in a folder located under the existing project called 
backup_version_2. 
 
If you want to run a previous version of V-STARS on a project created by the new release 
(probably to check any differences between the two versions), what you do depends on the 
situation. If you want to check something regarding a 3D file (displaying it, or doing some 
analysis for example), first export the 3D file in this new release version as an .XYZ or .TXT file, 
and then import it into the earlier version of V-STARS. If you want to do anything else, you will 
have to open a new project with the earlier version and reprocess the pictures from the 
beginning. 
 
The compatibility issues are summarized in Table 1 below. The 3D file format changes means 
new versions of WinTrans and the 3D Viewer are needed. If you do not use these programs, 
skip the next two sections. 

Table 1: 3D File format compatibility. 
 

Running Version 
 Existing 

Project Pre 4.5 Version 4.5 

Pre 4.5 OK 
OK (but can no longer run a Pre 4.5 version 
on the project – use the backup project 
folder) 

Version 
4.5 

NO (will get error message – 
Export 4.5  3D file(s) as .xyz, etc. 
file(s)  or reprocess images ) 

OK 
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WinTrans 3D file Compatibility  
Changing the 3D file format means your existing version of WinTrans will not read 3D files made 
by this new release of V-STARS (You will get a message stating “Source File Error” if you try to 
do so). V-STARS will automatically install a new version of WinTrans (Version 4.5) that can read 
the new 3D file format (and any old 3D file formats). However, be aware that it will write any new 
3D files in the new format which then cannot be read by previous versions of WinTrans. 
Because of this, avoid running the new WinTrans on old projects if you want to run the old 
V-STARS on those projects. 
 
NOTE: The installation will automatically configure your system so that the new V-STARS will 
use the new WinTrans and old V-STARS versions will use the old WinTrans. The New 
WinTrans will say “WinTrans 4.5” in the title bar to distinguish it from previous versions. 

3D Viewer Compatibility  
Because of the 3D file format change, your existing 3D Viewer program will not read 3D files 
written by the new V-STARS release (You will get a message that says “Unable to Read the 3D 
file” if you try to do so). A new 3D Viewer (Version 4.5) that will read all versions of 3D files will 
be automatically installed and configured so it is used when you double-click on a 3D file. The 
program is called “GSI3DViewer.exe”. It is installed in the same folder as the V-STARS 
executable. The default location of this folder is “C:\GSI\Vstars45”. However, if you changed the 
location of the V-STARS executable during the install, the 3D Viewer program will be stored 
there.  Include this file whenever you send 3D files to anyone for viewing.   
 
NOTE: When you install a copy or shortcut of the new version on the desktop, it will be 
displayed with a new icon to distinguish it from the old 3D Viewer.  You should remove any 
shortcuts or copies of the old 3D Viewer on your desktop.  

Release Required if Using Combo-Shot Mode   
There is a bug in previous releases that may cause incorrect operation when using M Combo-
Shot mode. You should use this version if you are using M Combo-Shot Mode. INCA3 cameras 
must have versions 06.06.01G Firmware or later. 
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Important Changes 
The following items are considered very important changes in V-STARS. 

AutoBar no longer required 
If you have ever forgotten to bring your AutoBar on a job, you will greatly appreciate this new 
feature. If V-STARS doesn’t find an AutoBar in any of the images, it will automatically setup an 
arbitrary coordinate system using the codes. 
 
However, be aware that without an AutoBar, the scale of the coordinate system is unknown. 
V-STARS will use the size of the codes specified in the project (3mm, 6mm, or 12mm) to get 
approximate scale for the project but this scale will only be good to 1-2%. If the project does not 
specify the size codes used in the project (Codes = Unknown), V-STARS will assume that the 
medium-sized (6mm) codes are used. In this case, the scale could be off by a factor of 2 or 
more. 
 
NOTE: You must turn on measuring of the code nugget points for the code scaling to be 
applied. 
 
It is assumed you will scale these projects by some accurate means (scale bars, 
transformations with scale, etc) in the end to get accurate scale. 

Multiple V-STARS sessions possible 
You can now run multiple, simultaneous V-STARS sessions on different projects. To do so, just 
start another V-STARS session and select or create the project. If you try to run V-STARS on 
the same project, you will get a message that you cannot do this. You can run multiple sessions 
on S projects, and on S projects and one M project, but not on multiple M projects. 
 
NOTE:  Because V-STARS reads the system data (camera, probe data, etc.) at start-up, if one 
V-STARS session updates this data, other V-STARS sessions will not be updated. You must 
close the other V-STARS sessions and re-open their projects if you want to access the updated 
data. 

AutoMeasure Improved 
The AutoMeasure process is now more reliable. You should now get more pictures and fewer 
bundle failures.  

Combo-Shot Improved 
The M Combo-Shot procedure is used with the V-STARS Pro-Spot target projector in M-mode. 
This procedure is especially useful on shiny, highly-reflective objects and/or objects that have 
both very dark and very bright areas. Typically such objects cannot be completely measured in 
a single exposure because some areas are too overexposed while others are too dim. 
The process is now faster, more reliable and often needs fewer pictures. In addition, you can 
select default values for different objects (dark, shiny, very shiny), and conditions (flash hot 
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spots). Finally, optional stability monitoring has been added to indicate whether the cameras, 
object or Pro-Spot have moved. 
 
See the Application Note, M Combo-Shot Procedure 2007-10-09, for a complete description of 
the procedure. 

Pan-tilt support added 
V-STARS now has controls for the new INCA3 pan-tilt unit. To access the pan-tilt 
control, click the Pan-tilt icon on the toolbar), or select Pan-tilt from the View menu. 
The Pan /Tilt Control Box will appear and look similar to that seen in Figure 1 below. 

 
 

 
The cameras in the project are listed in the left pane. If a camera is not connected to a pan-tilt 
unit, the camera will be grayed out. Select the camera you want to move by clicking on it in the 
left pane to highlight it. Press the desired button to move the highlighted camera in the indicated 
direction. Each press of the button will move the camera by 1 degree. Holding down the 
<CTRL> key while pressing the button will move the camera by 10 degrees. You can also type 
the desired position into the Setting field. When you press the <Enter> key, the camera will 
move to the entered position. If you make a mistake, just press <CTRL>-Z before pressing the 
<Enter> key. 
 
The limits for the tilt unit are +38.6 degrees, and -81 degrees. The limits for the pan unit are +/-
158.9 degrees. The Setting field indicates where the camera will go. The Current field indicates 
where it is at. You do not have to wait for the camera to reach the set position before changing 
the setting. To take a picture and see where the camera is aimed, press any of the trigger 
buttons. 
 
It is important that you return ALL the pan-tilt units to their zero positions before removing 
power. Otherwise they will think the position you left them at is the zero position when they are 
powered back on. This can cause problems. Pressing the Zero button will move both the pan 
and tilt axes to their zero positions. To minimize the likelihood of hitting something or snagging a 

 
 

Figure 1: Pan / Tilt dialog. 
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cable, the tilt is zeroed first, and then the pan is zeroed (If you want to zero just one axis, enter 0 
in the appropriate Setting field). When you press the Zero button, you will be asked whether you 
want to zero all the camera’s pan-tilt units or just the highlighted camera’s. Press the Confirm 
button to zero just the highlighted camera, or press the All button to zero them all. 
 
If a pan-tilt unit loses power, or hits an obstruction, it will lose track of its position which can 
cause problems (A likely cause is that you forgot to zero the pan-tilt unit before turning off its 
power). Pressing the Reset button will cause both the pan and tilt axes to do a reset procedure 
to re-establish their indexes. During this process, the axes will go thru their entire range of 
motion. Also, to minimize the likelihood of hitting something or snagging a cable, the tilt axis is 
reset first, and then the pan axis is reset. This means the entire process can take some time - 
about a minute – so you want to avoid forgetting to reset the cameras before removing power. 
When you press the Reset button, you will be asked whether you want to reset all the pan-tilt 
units or just the highlighted cameras. Press the Confirm button to reset just the highlighted one, 
or press the All button to reset them all. 

Tile and Auto-Tile Window Features Added 
The new “Tile” and “Auto-Tile” features size and arrange the various V-STARS windows 
automatically and dynamically, respectively to make the windows more visible and useful. 
Select Tile from the Window menu each time you want to automatically re-arrange the 
Windows. Selecting Auto-Tile will dynamically re-arrange the windows each time a window is 
opened or closed (it works the same as if you selected Tile every time a window opens or 
closes). 
 
AutoTile can be particularly useful in S-mode when you want to look at more than one picture at 
a time because it will automatically re-size the picture windows as you open and close them to 
fit them on the display while reserving an area for viewing the thumbnails. 

FTP to GSI Added 
Sending projects to GSI is now even easier because we have added 
the ability in V-STARS to send projects to GSI using FTP (File-
Transfer-Protocol). You must “archive” the projects using one of the 
two already available archiving options in V-STARS before using the 
FTP to GSI command. (Archiving takes all the appropriate files in the 
project, compresses them and puts them all in one archive file).  The 
entire procedure for sending projects to GSI is as follows: 
 

1) Under the Tools menu select either “Archive Project without 
Images” or “Archive Project with Images” (Figure 2). 
 
NOTE: If you are archiving with images, the images (.gsi files) must be located in or 
under the project. If they are not there, you can either use Windows Explorer or the 
“Import -> Images” command on the Project menu to import the images into the project 
before archiving. 

 

 
 
Figure 2: Archive V-
STARS projects and 
FTP to GSI. 

2) A DOS screen will appear that will display the archiving process. When done you will 
have an archive file in your project directory with the project name and the extension 
“.7z”. 
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3) Under the Tools menu, select FTP to GSI (Figure 2). A DOS screen will appear that will 

display the FTP process. 
 

NOTE:  Some companies don’t allow employees to ftp files directly to our site. If so, you 
will get a failure message. Contact your IT department to see how to ftp the data to us. 

3D Point Filtering Added 
When comparing the measured and design 
data in a 3D file, it is often helpful to remove (or 
keep) points that have large differences. Also, it 
is sometimes useful to remove points that are 
not in both data sets.  V-STARS can now filter 
points in this manner.  The filtered points are 
removed from both the measured and design 
data sets.   
 
WARNING!  The filtered points are deleted and 
cannot be recovered.  If you want to keep the 
original data, save it before filtering. 
 
To filter points, Select “Alignment” from the 3D 
file menu, and select either “Residuals – Quick” 
or “Residuals - Standard”. A dialog box similar 
to the one shown will appear. You can change 
the rejection limit if you like and press the 
“Recalc…” button to see the effect. Points 
above the rejection limit will be placed at the top 
of the list and will be marked with a red bar 
icon. Selecting the “Delete Rejected” check box 
will remove the rejected points from the 
measured and design data sets. Selecting 
“Delete Accepted” will delete the points that 
were below the rejection limit from both data 
sets. Selecting “Delete Unique Points” will delete any points that are not in both the measured 
and design data sets. 

 
 

Figure 3: 3D Point Filters. 

Proximity Point Labeling 
V-STARS further improves measurement automation with the addition of Proximity Point 
Labeling (PPL). PPLs allows you to automatically change point labels from the arbitrary ones 
assigned to them by the AutoMatch process to meaningful labels based on the point’s proximity 
to certain geometrical objects. A major benefit of PPL is targets no longer have to be precisely 
placed on objects in order to automatically relabel them. As long as they are placed anywhere 
on a supported geometrical object, they will be relabeled. 
 
As an example, PPLs allow you to place targets on an object (such as a bulkhead). Then, using 
the plane PPL you can relabel any targets on the bulkhead to whatever you desire (e.g., 
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AFT_BULKHEAD1, 2… N). These relabeled points can then be used by construction objects to 
automatically make measurements and construct geometry. 
 
NOTE: To use PPL you must have a SOLIDS license. To use NURBS surfaces for Proximity 
Point Labeling, you must have a SURFACES license. Currently, PPLs can only be used on S 
measurements. They are not yet supported in M-Mode. 
 
PPL objects are members of a 3D file and appear under the Proximity Labelers node within a 
3D file on the V-STARS project tree. 
 
In general terms, PPLs consist of 
 

1. A SOLIDS or NURBS object. Those supported are 
a. SOLIDS – plane, line, circle, sphere, cylinder 
b. NURBS – curve, surface 
 

2) A set of criteria that define 
a. The spatial relationship between the object and a point under consideration for 

relabeling 
b. The initial point label for relabeling 

 
To further illustrate the benefits and use of PPLs, consider that in a particular S-survey, the 
nominal location of a planar surface is known. A number of targets are randomly affixed to this 
surface for the survey. After the AutoMeasure procedure and final bundle adjustment are 
complete, these points are labeled arbitrarily as AutoMatched points. Because they are labeled 
arbitrarily, they can’t be used to automatically create a plane object via Construction Objects. 
However, using a PPL, those points that lie within a specified distance of the nominal plane are 
automatically assigned designated labels which in turn allow them to be utilized in a best-fit 
plane construction object. 
 
See the Application Note Proximity Point Labelers 2007-10-15 for a complete description. 

AutoRelabel without Manual Relabeling Possible 
In previous versions of V-STARS, the AutoRelabel command always did an alignment of the 
AutoRelabel files. If there were not at least four identically labeled points in both files, it was 
necessary to manually relabel four points 
prior to the AutoRelabel so it could do 
the alignment. Now, if the files are 
already aligned, the manual relabeling 
can be skipped when running 
AutoRelabel by unchecking the “Do 
Alignment” box (Figure 4). The 
AutoRelabel will use a default value of 1 
for the nearness threshold. 

 
 

Figure 4: Do Alignment option in AutoRelabel 
Wizard. 

 
This new feature is very useful, for 
example, when probing a set of points. 
Often, you may just want to probe these 
points as quickly as possible without 
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worrying about labeling them. Then, if you have a set of design values for the probed points, 
you can use AutoRelabel to relabel the measured probe points. In the past, even if the design 
and measured points were in the same coordinate system (which is often the case), you would 
still have to manually relabel four of the measured points before using AutoRelabel. Now, if they 
are in the same coordinate system, you can skip the manual relabel and just uncheck the “Do 
Alignment” check box. 

Plane-Line-Point (3-2-1) Alignment Added 
You can now do a 3-2-1 alignment using a plane, a line and a point. This feature is very useful 
when you want to align your coordinate system to physical features of an object. Usually, these 
features are targeted and you then make a best- fit plane and line using these targeted points. 
 
To do a Plane-Line-Point alignment, do the following: 
 

1) In the 3-D view, select a point, a line and a plane. You must select just one of each. In 
the example shown here, we have selected the plane, the line and a point at the bottom 
left corner of the object. 

 
2) Right click in the 3D View and select Plane-Line-Point from the Alignment menu. If the 

selection is grayed out, you have not selected one plane, one line, and one point. The 
Plane Line Point dialog box shown in Figure 5. 

 

 
 

Figure 5: Plane-line-point alignment setup. 

3) You can give the new coordinate system a name (we will call it “PLP”), otherwise it will 
be given the default name shown in the “New” field of the dialog. Select the plane and 
line orientation you desire. Type the values you desire for the location of the plane, the 
end of the line and the point in the appropriate fields. Since we want the coordinate axes 
to be nominally parallel with our original axes, and the origin to be nominally at the 
bottom left corner the default values shown are appropriate. 
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Figure 6: Plane-Line-Point alignment (before, left and after, right). 

NOTE:  The positive directions of the axes depend on the order in which you selected 
the points to make the plane and the line (Figure 6). Rather than try to describe these 
dependencies, it is better to use the flip buttons to flip the direction of the axes if they are 
not what you want. 

Fixed Slow Opening and Closing with Anti-Virus Software  
We discovered that anti-virus software (which most customers use) was causing V-STARS to 
take a long time to open and close. This is fixed. Opening and especially closing V-STARS 
should now be much faster. 
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Bug Fixes 
The following bugs have been fixed in this release. 

Probe Calibration Scale Error 
In previous versions, the new Probe calibration routine did not properly scale the probe 
coordinates. This was not an issue if you were re-calibrating the probes because it would use 
the scale from the previous calibration which was good. It is only an issue on an initial 
calibration of the probes. Since probes are always initially calibrated by GSI, this would only be 
an issue if you were using your own custom-made probe. Now it is fixed for all situations. 

Pressing OK button in probe calibration window can cause crashes 
Fixed. 

When exporting lines, the line length is now included 
Fixed. 

Tolerance bar in graphical view displays two values twice 
Fixed. 

Open GL crashes eliminated? 
In previous versions, V-STARS would sometimes crash when doing various operations in the 
3D graphical view (rotating the view, etc.). This should no longer happen. 

Instability in M mode with Inca1s and Inca2s 
In previous versions, when in M-Mode, the INCA1 and INCA2 cameras could disconnect if you 
triggered too fast. This is now fixed. 

Switching ARM Baseline Regenerates Output files 
In previous versions, if you changed the ARM baseline V-STARS did not generate new output 
files.  This was confusing and inconsistent.  Now it will generate new output files when a new 
baseline is chosen.   
 
WARNING!  The new output files will overwrite the old ones.  Move or rename the old files if 
you want to save them.  
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